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How to Use This Manual
The following shows the tips for using this manual.
 To display or print this manual, either Adobe® Acrobat® (7.0 or later) 

or Adobe® Reader® (7.0 or later) is required.

 You can use the Adobe® Acrobat® or Adobe® Reader® Search tool to 
search this manual.
For details, refer to Adobe® Acrobat® or Adobe® Reader® Help.

 Use the [Page Up] key to return to the previous page, and the [Page 
Down] key to go to the next page.

 Click a blue character string, tab or contents/index title (where the mouse 

cursor changes into a shape such as ) to jump to the link.

- Common for all pages

- Contents page

- Index pageJumps to the first page of each chapter.
These tabs are on every page.

TOP: Jumps to the cover page.
Contents: Jumps to the contents page.
Index: Jumps to the index page.
These tabs are on every page.

Jumps to this page.
Click on a blue 
character string to jump 
to the link.

Click on a title to jump to the link.

Click on a page number to jump to the link.
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Introduction
rks of Intel Corporation or its 
ther countries.
 © ABBYY. OCR by ABBYY
demarks of ABBYY Software, 
some jurisdictions.
or registered trademarks of 

ark of DENSO WAVE 
 other countries.
emark of PFU Limited in 

uct names are the registered 
 respective companies.

-4-5 Minatomirai, Nishi-ku, 
7, Japan
Thank you for using ScandAll PRO.
The contents of this manual may be changed following 
updates of ScandAll PRO.
The latest version of the ScandAll PRO User's Guide is 
available from the Web site below. An Internet connection is 
required for downloading.
http://www.fujitsu.com/global/support/computing/peripheral/
scanners/manual/scandall.html

About This Product
ScandAll PRO is an application that enables you to display 
and edit images scanned with the Image Scanner fi Series.
This manual describes how to use ScandAll PRO for scanning 
with the Image Scanner fi Series.
For details about the functions of ScandAll PRO, refer to the 
ScandAll PRO Help.

Trademarks
Microsoft, Windows, Windows Server, Windows Vista, and 
SharePoint are either registered trademarks or trademarks of 
Microsoft Corporation in the United States and/or other 
countries.
ISIS is a trademark of Open Text.
Adobe, Acrobat, and Reader are either registered trademarks 
or trade names of Adobe Systems Incorporated in the United 
States and/or other countries.

Intel and Intel Core are tradema
subsidiaries in the U.S. and/or o
ABBYY™ FineReader™ Engine
ABBYY and FineReader are tra
Ltd. which may be registered in 
Kofax and VRS are trademarks 
Kofax Limited.
QR Code is a registered tradem
INCORPORATED in JAPAN and
PaperStream is a registered trad
Japan.
Other company names and prod
trademarks or trademarks of the

Manufacturer
PFU Limited
YOKOHAMA i-MARK PLACE, 4
Yokohama, Kanagawa, 220-856
© PFU Limited 2011-2018

http://www.fujitsu.com/global/support/computing/peripheral/scanners/manual/scandall.html
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Use in High-Safety Applications
This product has been designed and manufactured on the 
assumption that it will be used in office, personal, domestic, 

regular industrial, and general purpose applications. It has not 
been designed and manufactured for use in applications 
(simply called "high-safety applications" from here on) that 
directly involve danger to life and health when a high degree 
of safety is required, for example, in the control of nuclear 
reactions at nuclear power facilities, automatic flight control of 
aircraft, air traffic control, operation control in mass-transport 
systems, medical equipment for sustaining life, and missile 
firing control in weapons systems, and when provisionally the 
safety in question is not ensured. The user should use this 
product with adopting measures for ensuring safety in such 
high-safety applications. PFU Limited assumes no liability 
whatsoever for damages arising from use of this product by 
the user in high-safety applications, and for any claims or 
compensation for damages by the user or a third party.
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Conventions

Windows 8 (*1)

)

Windows 8.1 (*1)

it)

Windows 10 (*1)

it)

it)

-bit) Windows Server 2016
(*1)

r 2007 SharePoint 
Server

SharePoint

010

Indication
Abbreviations Used in This Manual
The following abbreviations are used in this manual:

Product Indication

Windows Vista® Home Basic (32-bit/64-bit) Windows Vista (*1)

Windows Vista® Home Premium (32-bit/64-
bit)

Windows Vista® Business (32-bit/64-bit)

Windows Vista® Enterprise (32-bit/64-bit)

Windows Vista® Ultimate (32-bit/64-bit)

Windows Server® 2008 Standard (32-bit/
64-bit)

Windows Server 2008 
(*1)

Windows Server® 2008 R2 Standard (64-
bit)

Windows® 7 Home Premium (32-bit/64-bit) Windows 7 (*1)

Windows® 7 Professional (32-bit/64-bit)

Windows® 7 Enterprise (32-bit/64-bit)

Windows® 7 Ultimate (32-bit/64-bit)

Windows Server® 2012 Standard (64-bit) Windows Server 2012 
(*1)

Windows Server® 2012 R2 Standard (64-
bit)

Windows® 8 (32-bit/64-bit)

Windows® 8 Pro (32-bit/64-bit)

Windows® 8 Enterprise (32-bit/64-bit

Windows® 8.1 (32-bit/64-bit)

Windows® 8.1 Pro (32-bit/64-bit)

Windows® 8.1 Enterprise (32-bit/64-b

Windows® 10 Home (32-bit/64-bit)

Windows® 10 Pro (32-bit/64-bit)

Windows® 10 Enterprise (32-bit/64-b

Windows® 10 Education (32-bit/64-b

Windows Server® 2016 Standard (64

Microsoft® Office SharePoint® Serve

Microsoft® SharePoint® Server 2010

Microsoft® Windows® SharePoint® 
Services 3.0

Microsoft® SharePoint® Foundation 2

Microsoft® SharePoint® Online

Product
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Arrow Symbols in This Manual
Right-arrow symbols () are used to separate icons or menu 
options you should select in succession.

u  [Scanner Settings].

Manual
re reprinted with permission 

nual are subject to change 
roduct development. 

ffers from the screen 
e by following the actual 
 to the user's manual of the 
g.
is manual are of the TWAIN 
 PRO (image scanning 

rom Windows Vista. The 
rations differ by the operating 

note that with some scanner 
ions may differ from this 

AIN driver or the ISIS driver. 
 provided upon updating the 

es in This Manual
r and the name of the display 

ribed in this manual may differ 
re using.
r's Guide for your scanner.

Adobe® Acrobat® Adobe Acrobat

Product Indication
*1: Where there is no distinction between the different versions of the 
above operating system, the general term "Windows" is used.

Example: Select the [Scan] men

Screen Examples in This 
Microsoft product screenshots a
from Microsoft Corporation.
The screen examples in this ma
without notice in the interest of p
If the actual displayed screen di
examples in this manual, operat
displayed screen while referring
scanner application you are usin
The screen examples used in th
driver, ISIS driver, and ScandAll
application).
This manual uses screenshots f
windows that appear and the ope
system that you are using. Also 
models, the screens and operat
manual when you update the TW
In this case, refer to the manual
driver.

Scanner Component Nam
The button names on the scanne
area of the operation panel desc
depending on the scanner you a
In this case, refer to the Operato

Adobe® Acrobat® DC

Adobe® Reader® Adobe Reader

Adobe® Acrobat® Reader® DC
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This chapter describes the overview, features and starting procedures of ScandAll PRO.

1.1 Overview........................................................................................................................

1.2 Features ........................................................................................................................

1.3 System Requirements ...................................................................................................
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1.1 Overview

ScandAll PRO is an image scanning application, which 
conforms with both TWAIN/ISIS standards. ScandAll PRO can 
scan documents to make image data.

Configured for a TWAIN driver, ISIS driver, PaperStream IP 
(TWAIN) driver, PaperStream IP (ISIS) driver or Kofax VRS 
(*1), ScandAll PRO allows you to scan a document to make 
image data. A TWAIN driver, ISIS driver, PaperStream IP 
(TWAIN) driver, PaperStream IP (ISIS) driver or Kofax VRS is 
required for scanning.
You can save the scan settings as profiles and perform a scan 
based on your business.
ScandAll PRO is suitable for digitalizing paper documents for 
routine work, such as business or application forms. (For 
corporate use)

*1: An application that can easily be used to create high-quality images. 
VRS can also detect and automatically correct errors that may occur 
while scanning. For example, VRS corrects skewed or smudged 
characters due to the colored or shaded effects.
Kofax VRS can be used for scanners that support Kofax VRS.

HINT
For details about the functions of ScandAll PRO, refer to the ScandAll 
PRO Help.
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 Launches the specified application while using the output image file 
arameter.
images, and if any exist, changes 
t thumbnail (fi-6800 only).
 images by changing the 
 be easily sorted.

ply the same ScandAll PRO settings 
uter.

you want to apply the same settings 
ou only need to import the profile 
 computer.

1.2 Features

ScandAll PRO has the following features:
Various Scan Settings
 Allows batch processing (batch scan), enabling scan operations with 

scan conditions, file format, and file save destination specified. You 
can also save the specified scan settings as a profile.

 Allows scan operations with a single touch on a keyboard according 
to specified hot key controls.

 Allows you to set events, enabling batch scans with a single press of 
the [Scan] button or [Send to] button on the scanner.

Display/Edit/Save Functions to Meet Your Needs
 Shows multiple files side-by-side, which allows the files to be 

compared easily.
 Allows editing scanned images. You can overwrite the data, or save 

the edited data with a different file name or in a different file format 
than those used at the time of scanning. (An edited PDF file cannot 
be saved in a different file format.)

 Outputs both color/monochrome images simultaneously with a single 
scan. (When using a scanner that supports the multi-image output 
function.)

 Inputs/outputs BMP, JPEG, JPEG2000, TIFF, PDF and PDF/A files.
PDF and PDF/A files can also be outputted as searchable PDF files 
and high-compression PDF files.

Other Useful Functions
 Automatically saves the scanned images in the specified server by 

linking with FTP server or SharePoint.
 Sends the scanned images as an attached file by linking with an e-

mail program.
 Classifies pages of a document in a specified unit and saves them in 

separate files by using patch codes or barcodes.
 Performs barcode recognition, or character recognition with Zone 

OCR, over the scanned images. Both functions can output the 
recognition results to the indexing information file and the results can 
be used as file names of the scanned images.

or indexing information file as a p
 Checks for errors in the scanned 

the background color of the targe
 Marks thumbnails of the scanned

background color so that they can
 Imports and exports profiles to ap

to ScandAll PRO in another comp
This function can be useful when 
to multiple computers, because y
without configuring them for each
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-bit application which can operate 

e screens may not be shown 
e font size.

ing to the file size of the scanned 

1.3 System Requirements

it/64-bit)
32-bit/64-bit)
prise (32-bit/64-bit)
 (32-bit/64-bit)
2-bit/64-bit)

prise (32-bit/64-bit)
tion (32-bit/64-bit)

016 Standard (64-bit)

2.2 GHz or higher recommended

mended

r more, and 65536 colors or more

ee space (*3)
System Requirements
The system requirements for ScandAll PRO are as follows:

*1: ScandAll PRO is supported as a 32
on a 64-bit operating system.

*2: When the font size is too large, som
correctly. In this case, decrease th

*3: Required disk space varies accord
images.

Operating 
system (*1)

Windows Vista® Home Basic (32-bit/64-bit) (Service 
Pack 2 or later)
Windows Vista® Home Premium (32-bit/64-bit) 
(Service Pack 2 or later)
Windows Vista® Business (32-bit/64-bit) (Service Pack 
2 or later)
Windows Vista® Enterprise (32-bit/64-bit) (Service 
Pack 2 or later)
Windows Vista® Ultimate (32-bit/64-bit) (Service Pack 
2 or later)
Windows Server® 2008 Standard (32-bit/64-bit) 
(Service Pack 2 or later)
Windows Server® 2008 R2 Standard (64-bit) (Service 
Pack 1 or later)
Windows® 7 Home Premium (32-bit/64-bit) (Service 
Pack 1 or later)
Windows® 7 Professional (32-bit/64-bit) (Service Pack 
1 or later)
Windows® 7 Enterprise (32-bit/64-bit) (Service Pack 1 
or later)
Windows® 7 Ultimate (32-bit/64-bit) (Service Pack 1 or 
later)
Windows Server® 2012 Standard (64-bit)
Windows Server® 2012 R2 Standard (64-bit)
Windows® 8 (32-bit/64-bit)
Windows® 8 Pro (32-bit/64-bit)
Windows® 8 Enterprise (32-bit/64-bit)

Operating 
system (*1)

Windows® 8.1 (32-b
Windows® 8.1 Pro (
Windows® 8.1 Enter
Windows® 10 Home
Windows® 10 Pro (3
Windows® 10 Enter
Windows® 10 Educa
Windows Server® 2

CPU Intel® Core™2 Duo 

Memory 2 GB or more recom

Display 
resolution (*2)

1024 × 768 pixels o

Disk space 1.3 GB or more of fr
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Supported Models
The scanner models that ScandAll PRO supports are as 
follows:

fi-5950/fi-6800/fi-6400/fi-7700/fi-7700S/fi-7600/fi-6770/
fi-6770A/fi-6750S/fi-6670/fi-6670A/fi-7480/fi-7460/
fi-5530C2/fi-7300NX/fi-7180/fi-7160/fi-7140/fi-7280/fi-7260/
fi-7240/fi-7030/fi-6110/fi-6140Z/fi-6130Z/fi-6240Z/
fi-6230Z/fi-5015C/fi-6140/fi-6130/fi-6240/fi-6230
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1.4 Launching

The procedure to start ScandAll PRO is as follows:

1 Select the [Start] menu  [All Programs]  [Fujitsu 
ScandAll PRO]  [ScandAll PRO].
 ScandAll PRO starts up.
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This chapter describes how to scan documents with the scanner using ScandAll PRO.

2.1 Selecting a Scanner Driver............................................................................................

2.2 Selecting a Scanner Model............................................................................................

2.3 Configuring Scan Settings .............................................................................................

2.4 Scanning Methods.........................................................................................................

2.5 Scanning Methods (Scan) .............................................................................................

2.6 Scanning Methods (Batch Scan) ...................................................................................

2.7 Advanced Scanning.......................................................................................................

2.8 Useful Post-Scan Functions ..........................................................................................

2.9 Exporting and Importing Profiles ...................................................................................

2.10 Premium Option Enabling Condition ...........................................................................



Index

Chapter 2 Scanning with ScandAll PRO

Introduction

TOP

16

Prior to Use

Scanning with 
ScandAll PRO

Contents

references].
.

her of the drivers under 

e the settings.

2.1 Selecting a Scanner Driver

The following scanner drivers are supported by the Image 
Scanner fi Series.
 TWAIN driver (conforms with the TWAIN standard)
 ISIS driver (conforms with the ISIS standard)
 PaperStream IP (TWAIN) driver (conforms with the TWAIN standard)
 PaperStream IP (ISIS) driver (conforms with the ISIS standard)
 Kofax VRS

This chapter describes the steps to scan documents with a 
TWAIN driver or an ISIS driver.

There is no significant difference between a TWAIN driver and 
an ISIS driver. Choose one to suit your requirements.

The following explains how to select the scanner driver to use 
with ScandAll PRO.

1 Select the [Tool] menu  [P
The [Setup] dialog box appears

2 On the [Scan] tab, select eit
[Device Driver].

3 Click the [OK] button to sav

HINT
 In ScandAll PRO, [TWAIN] is selected by default.
 For functional details of the TWAIN driver, refer to the TWAIN Driver 

Help.
 For functional details of the ISIS driver, refer to the ISIS Driver Help.
 For details about the PaperStream IP (TWAIN/ISIS) driver, refer to 

the PaperStream IP Driver Help.
 For details about the Kofax VRS, refer to the Kofax VRS helps.
 Kofax VRS can be used for scanners that support Kofax VRS.
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ISIS driver:

2.2 Selecting a Scanner Model

You need to select a scanner to use before you scan a 
document.
The following explains how to select the scanner.

1 Select the [Scan] menu  [Select Scanner].
The [Select Scanner] dialog box appears.

2 Select a scanner you want to use, and click the [Select] 
button.
Select the scanner model that you connected to your computer. Note 
that the indication of the scanner model name depends on the 
selected scanner driver.

TWAIN driver:
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ISIS driver:

n the respective drivers, refer to the 
 you are using.

the settings, click the [OK] 

d.

2.3 Configuring Scan Settings

The scan settings are configured in the scanner driver's setup 
dialog box.

1 Select the [Scan] menu  [Scanner Settings].
The scanner driver's setup dialog box appears.

TWAIN driver:

For the configurable parameters i
Operator's Guide for the scanner

2 When you have completed 
button.
The scan settings are configure

HINT
The scanner driver's setup dialog box specifications differ depending on 
the scanner.
For details, refer to the Operator's Guide for the scanner you are using.
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2.4 Scanning Methods

There are two ways to scan documents by using ScandAll 
PRO.

Scan

With Scan, you can perform a scan easily without configuring 
complicated settings.
Each time you perform a scan, you can change settings as 
necessary, such as the file format, saving destination, and 
scan settings.
For details, refer to "2.5 Scanning Methods (Scan)" (page 20).

Batch Scan

With Batch Scan, you can save various settings as a profile 
beforehand and then scan documents with the profile.
Saving profiles means that you do not need to configure 
settings for every scan. You can create more than one profile 
beforehand, so that you can switch to the appropriate scan 
settings by selecting a profile for the scan.
For details, refer to "2.6 Scanning Methods (Batch Scan)" 
(page 23).
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 box, configure various 
the scanned images.

2.5 Scanning Methods (Scan)

 items you can configure, refer to 
With Scan, you can configure settings, such as the file format, 
saving destination, and scan settings as necessary.

1 Load the document in the scanner.
For how to load the document in the scanner, refer to the Operator's 
Guide for the scanner you are using.

2 Select the [Scan] menu  [Scan Settings].
The [Scan Settings] dialog box appears.

3 In the [Scan Settings] dialog
settings such as for saving 

HINT
For information about the setting
the ScandAll PRO Help.
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.
n the respective drivers, refer to the 
 you are using.

the settings, click the [OK] 

ettings] dialog box.
The scanner driver's setup dialog box appears.

TWAIN driver:

5 Configure the scan settings
For the configurable parameters i
Operator's Guide for the scanner

6 When you have completed 
button.
You are returned to the [Scan S
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Contents7 Click the [Scan] button. After the document is scanned, the scanned image(s) are displayed
on the ScandAll PRO window, and then saved to a file.

ethods other than scanning with 
anning" (page 26).

check box in the [Scan Settings] 
e(s) will no longer be saved to a 

a file, select the [File] menu  

same settings afterwards, select 

nctions and operations of ScandAll 
RO Help.
For information about scanning m
[Scan], refer to "2.7 Advanced Sc

ATTENTION
 Do not connect and disconnect the scanner and other USB 

devices during scanning.
 Do not switch users during scanning. Doing so will cancel 

scanning.

HINT
When using the TWAIN driver, clicking the [Scan] button may 
display the scanner driver's setup dialog box. If so, you can also 
change the settings in the dialog box displayed.
Click the [Scan] button to scan the document.
Click the [Close] button when you finish scanning.

If you do not want to display the scanner driver's setup dialog box, 
clear the [Show TWAIN dialog before each batch scan process] 
check box in the [Scan Settings] dialog box.

HINT
 If you clear the [Save to file] 

dialog box, the scanned imag
file. To save the image(s) to 
[Save As].

 To scan documents with the 
the [Scan] menu  [Scan].

 For more details about the fu
PRO, refer to the ScandAll P
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ry:
on a default profile:

 in the [Profile Editor] dialog box.

on an existing profile:
ange the settings for, and click the 

om the profile list is displayed as a
itor] dialog box.

xisting profile:
ange the settings for, and click the 

s in the [Profile Editor] dialog box.

m the profile list:
lete, and then click the [Delete] 

ed.

2.6 Scanning Methods (Batch Scan)

With Batch Scan, you can save various settings as profiles 
beforehand and then scan documents by using such profiles.

Creating and Editing Profiles

1 Select the [Scan] menu  [Batch Scan Settings].
The [Batch Scan Settings] dialog box appears.

2 Do the following as necessa
 To create a new profile based 

Click the [Add] button.
 The default settings appear

 To create a new profile based 
Select a profile you want to ch
[Copy] button.
 The profile you selected fr

new profile in the [Profile Ed

 To change the settings of an e
Select a profile you want to ch
[Edit] button.
 The selected profile appear

 To delete an existing profile fro
Select a profile you want to de
button.
 The selected profile is delet

Profile list
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ContentsWhen you create a profile, the profile is added in the profile list. 3 In the [Profile Editor] dialog box, configure settings for 
scanning and saving the scanned images.

Scan Settings] dialog box.
sing the [Add] or [Copy] button are

r, only [00: Current Setting] is 
tail Scanner Settings].

 items you can configure, refer to 
4 Click the [OK] button.
You are returned to the [Batch 

Added or copied profiles by u
added to the profile list.

HINT
 The profile showing [Template] at [Type] in the dialog box is a 

default sample profile. It cannot be used for actual scanning. 
Use this profile as the base of new profiles.

 When the title line of each parameter in the profile list is clicked, 
profiles other than [Template] are sorted. 

 You can specify the default profile beforehand.
1 Select the [Tool] menu  [Preferences] and specify a 

profile name for [Initial setting for profile] on the [Scan] tab.
2 For [Batch Scan Setting], create a profile with the same 

name as the one you specified.
3 An asterisk (*) is displayed to the right of the created profile 

type. The settings of the profile are set as default.
When you create a new profile with the [Add] button, the profile 
is created with the default settings values.

ATTENTION
When you use the TWAIN drive
available for [Setting File] in [De

HINT
For information about the setting
the ScandAll PRO Help.
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1 Load the document in the scanner.

After the document is scanned, the scanned image(s) are displayed
on the ScandAll PRO window, and then saved to a file.

sing the [Scan] menu or by 
atch Scan Settings] dialog box as 
fer to the ScandAll PRO Help.

med, the batch scan working state 
tically. Because only one working 
 each scanning profile at a time, 
rwritten with the one last used. 

 scan working state can be 
u  [Restore Batch Scan]. For 

atch scan, refer to "Restarting a 
ge 56).
 inserted, replaced, or added to the 
 images are edited after performing 
he changed contents from the 
2 Select a profile from the [Select the Batch Profile] drop-
down list on the toolbar.

3 Click the [Start Batch Scan] button.

ATTENTION
 Do not connect and disconnect the scanner and other USB 

devices during scanning.
 Do not switch users during scanning. Doing so will cancel 

scanning.

HINT
 You can perform a scan by u

configuring settings in the [B
well. For more information, re

 When a batch scan is perfor
is temporarily saved automa
state is temporarily saved for
the saved state is always ove
The temporarily saved batch
restored from the [Scan] men
details on how to restore a b
Suspended Batch Scan" (pa

 If another scan is appended,
document batch, or scanned
a batch scan, you can save t
[File] menu  [Save].
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2.7 Advanced Scanning

ScandAll PRO allows you to scan documents by various 
methods.
The following shows the scanning methods list.

Scanning Methods List

Changing the scanning method
 "Duplex Scanning Using the ADF Virtual Duplex Option (fi-6750S/fi-

7700S)" (page 27)

Setting post-scan operations and processes
 "Saving Scanned Image in PDF File Format" (page 29)
 "Dividing a Multipage Document Using Patch Codes" (page 31)
 "Dividing a Multipage Document Using Barcodes" (page 34)
 "Specifying the Result of Zone OCR as a File Name" (page 44)
 "Specifying the Result of Barcode Recognition as a File Name" (page 

48)
 "Saving Folders for Each Batch Scan" (page 52)
 "Saving Scanned Images from a Batch Scan to SharePoint Server" 

(page 54)
 "Restarting a Suspended Batch Scan" (page 56)
 "Outputting Indexing Information File and Linking with an Application" 

(page 57)
 "Detecting Errors in the Scanned Document (fi-6800)" (page 61)

Changing the scanner's scan responses
 "Using the Scanner Buttons to Start a Scan Quickly" (page 41)
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Option (fi-6750S/fi-7700S)

The ADF Virtual Duplex option allows you to scan the front of 

When selecting the Batch Scan option
Display the profile to be used for scanning in the [Profile Editor] dialog 
box. On the [Scan] tab, select [ADF (Virtual Duplex)] from [Scan 
Type].

r
 box, select [ADF (Virtual Duplex)] 

ing with the ISIS driver, configure 
cting the Scan option" or "When 
".
the pages of a document first, and then scan the back sides in 
succession. It then automatically sorts these scanned pages 
in the correct order.

1 Load the document face-down on the ADF paper chute.
For how to load the document on the ADF paper chute, refer to the 
Operator's Guide for the scanner you are using.

2 In ScandAll PRO, specify Duplex Scan mode.
Configure the parameter as one of the following:

When scanning with the Scan option
Select the [Perform ADF virtual duplex scanning] check box in the 
[Scan Settings] dialog box.

When using a scanner drive
In the [TWAIN Driver (32)] dialog
from [Scan Type].

JKL JKL

JKL JKL

DEF

1 2
3 4

5 6

1
2

3
4

5
6

ABC DEF

ABC

Front Back

Sort
(Auto)

HINT
To perform virtual duplex scann
the setting for either "When sele
selecting the Batch Scan option
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When the scanning is complete, a message appears to prompt you

to reload the document face-up.

ATTENTION
 The ADF Virtual Duplex option is not available once you have 

selected any of the following. To use the option, change the 
settings in ScandAll PRO or in the scanner driver.

ochrome simultaneously] and [Sort 
tomatically] check boxes on the 
eme] tab in the [Profile Editor] 

[Use job separator (patch code)], 
e)], and [Use job separator (special 
 [Document separation] tab in the 

heck box in the [Multi Image] 
d by clicking the [Enable Multi 
WAIN Driver (32)] dialog box of the 

k Page Skip] check boxes in the 
is opened by clicking the [Option] 
r (32)] dialog box of the TWAIN 

[Blank Page Deletion] on the 
f the ISIS driver.
Front Image #2] check boxes for 
de] on the [Image Processing] tab 

 sorted if the page count on the 
on the back side.
4 Load the document face-up on the ADF paper chute.
For how to load the document on the ADF paper chute, refer to the 
Operator's Guide for the scanner you are using.

5 Click the [Yes] button.

The back sides of the pages are scanned.
When the scanning is complete, the pages of the scanned
document are sorted automatically.

ATTENTION
When scanning the back sides of the pages of a document, 
carefully load the document so that:
 The document is scanned from the last page.
 The pages are not upside down.

- The [Output color and mon
color and monochrome au
[File format and Name sch
dialog box.

- Any of the [Separate per], 
[Use job separator (barcod
paper)] check boxes on the
[Profile Editor] dialog box.

- The [Multi Image Output] c
dialog box, which is opene
Image] check box in the [T
TWAIN driver.

- The [Split Image] and [Blan
[Option] dialog box, which 
button in the [TWAIN Drive
driver.

- The [On] check box under 
[Blank Page Deletion] tab o

- The [Front Image #1] and [
[Camera] under [Image Mo
of the ISIS driver.

 The scanned images are not
front pages differs from that 
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ScandAll PRO allows you to create PDF files easily without 
any special steps. By changing the compression rate, you can 

When scanning with the Scan option
Select a file format from [File Format] in the [Scan Settings] dialog 
box.

can option
o use for scanning your file in the 
the [File format and Name scheme] 
from [File Format].
reduce the size of a PDF file.
ScandAll PRO is recommended for scanning in color or 
grayscale mode.

The procedure is as follows:

1 Load the document in the scanner.
For how to load the document in the scanner, refer to the Operator's 
Guide for the scanner you are using.

2 In ScandAll PRO, select the file format to save the 
scanned images from the following:
 PDF File
 SinglePage PDF File
 PDF/A File
 SinglePage PDF/A File

When selecting the Batch S
Display a profile name you want t
[Profile Editor] dialog box. Select 
tab, and then select a file format 

ATTENTION
The password to open a PDF file cannot set for the PDF/A File 
format.

HINT
A [PDF File] or [SinglePage PDF File] is saved in a format 
compatible with Adobe Acrobat 4.0 (PDF 1.3), while a [PDF/A File] 
or [SinglePage PDF/A File] is saved in a PDFA1b format (format 
for an archive of digital documents based on PDF 1.4).
Selecting [SinglePage PDF File] or [SinglePage PDF/A File] 
creates one file per scanned image, and selecting [PDF File] or 
[PDF/A File] creates one file containing multiple scanned images.
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Option] button.
The [Output PDF file] dialog box appears.
In this dialog box, you can change the compression rate for creating a 
file, make searchable PDF files, and set a password to open a PDF 
file.

4 Perform a scan with ScandAll PRO.
After the document is scanned, the scanned image(s) are displayed

on the ScandAll PRO window, and then saved as a PDF file.

HINT
For details about the [Output PDF file] dialog box, refer to the 
ScandAll PRO Help.

HINT
 You can configure the settings not to display the scanned 

image(s) on the ScandAll PRO window when you scan 
documents. For more information, refer to the ScandAll PRO 
Help.

 You can edit or view the images scanned by ScandAll PRO 
after the ScandAll PRO window is closed. For more information, 
refer to the ScandAll PRO Help.
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Codes

ScandAll PRO supports the Job Separation function using 

dAll PRO, and then open the 

 "2.6 Scanning Methods (Batch 

ation] tab, and then select the 
de)] check box.

 When you copy a printed patch code sheet with a copy 
machine, print it with the same size and color density of the 
original sheet.

 Using the same patch code sheets repeatedly may decrease 
 to accumulated dirt on the sheets. 
not recognized correctly or get 
de sheets.
patch code sheets. This function allows you to divide scanned 
images of a multipage document by a specified unit without 
interrupting the ongoing scan, and save them respectively in 
separate folders. When the output file format is set to 
multipage PDF or TIFF, and multipage document is scanned, 
the pages can be divided by the specified unit and saved as 
separate files.

The procedure is as follows:

1 Prepare patch code sheets.
The PDF file for use as a patch code sheet comes with four size types 
(A3, A4, Double Letter and Letter). Before using the patchcode-based 
Job Separation function, you need to select the [Start] menu  [All 
Programs]  [Fujitsu ScandAll PRO]  [Patch Code]  [Job 
Separation (A3)], [Job Separation (A4)], [Job Separation 
(DoubleLetter)], or [Job Separation (Letter)], and then print as many 
of the PDF file of the specified size type as you need.

2 Create a new profile in Scan
[Profile Editor] dialog box.
For how to create profiles, refer to
Scan)" (page 23).

3 Select the [Document separ
[Use job separator (patch co

ATTENTION
 Take note of the following when you print out a patch code 

sheet:
- Use blank white paper.
- Set the scaling to 100%.

The sheet is not recognized correctly when printed in a size 
smaller than the original.

- Do not save toners.
The sheet is not recognized correctly if the print is too light.

- Do not use thin paper in order to avoid bleed-through.
When the prints are seen through the paper, the scanner may 
recognize the paper as a duplex printed paper.

the recognition accuracy due
If the patch code sheets are 
smudged, print new patch co
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HINT
 To not save the patch code sheet images, select the [Remove 

job separator] check box.
 In Duplex Scan mode, you can disable the save of images on 

HINT
Follow the procedure below to save images of a scanned 
document that are separated by patch code sheets, in separate 
folders.

 [Document Counter] to saving 
ring 1] and [Page Counter] to 

Rule] check box on the [File format
the [Profile Editor] dialog box, and
n.
x appears.
older delimiters], [Character string

Settings applied].

elimiters] are used for the saving

nt Counter] is used for the folder
ages are saved in these folder.

image0001.jpg
0001

image0002.jpg

image0001.jpg
0002

image0002.jpg

image0001.jpg
0003

image0002.jpg

 folders
4 Insert the patch code sheets wherever you want the file/
folder to separate.
Load the document with the patchcode-printed sheets face-down on 
the ADF paper chute.

5 Specify the created profile and perform a batch scan.
For how to perform a batch scan, refer to "2.6 Scanning Methods 
(Batch Scan)" (page 23).

the back of the patch code sheet by selecting the [Remove next 
page of job separator] check box.

Patchcode-printed sheets

This section explains how to set
folder names, and [Character st
scanned document file names.

1 Select the [Use the Name 
and Name scheme] tab in 
click the [Name Rule] butto
The [Name Rule] dialog bo

2 Set [Document Counter], [F
1], and [Page Counter] in [

Items set above [Folder d
folder names.
In this example, [Docume
names, and the scanned im
Saving example:

SavingWhen specifying
[Document Counter] as
folder names
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If [Folder delimiters] is not set, no folders are created, and
[Document Counter], [Character string 1], and [Page Counter]
will be the file name.
Saving example:
0001image0001.jpg
0001image0002.jpg

0002image0001.jpg
0002image0002.jpg

0003image0001.jpg
0003image0002.jpg

When not specifying
[Document Counter] as
folder names

Saving Folder
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ScandAll PRO supports the Job Separation function using 
barcode-printed sheets. This function allows you to divide 

r one-dimensional barcodes 
onal Barcode Detection 

PDF417 detection, refer to "PDF417 
.

Example of One-dimensional Barcode

Field width

Alphanumeric mix: Up to 1850 
characters
Numbers: Up to 2710 digits
Binary data: Up to 1108 bytes

Alphanumeric mix: Up to 395 
characters
Numbers: Up to 652 digits
Kanji, full-width Kana 
(Japanese): Up to 167 
characters

CODE39

R code
scanned images of a multipage document by a specified unit 
without interrupting the ongoing scan, and save them 
respectively in separate folders. When the output file format is 
set to multipage PDF or TIFF, and multipage document is 
scanned, the pages can be divided by the specified unit and 
saved as separate files. You can create files and folders with a 
name that includes the document counter or the text 
recognized from a barcode.

ScandAll PRO can detect the following types of barcodes:
One-dimensional Barcodes

*1: Operates in Full ASCII mode.

For details on the parameters fo
detection, refer to "One-dimensi
Parameters" (page 35).

Two-dimensional Codes

 For details on the parameters for 
Detection Parameters" (page 35)

Code Character set Field width

UPC/EAN/
JAN

Numbers UPC:12 (UPC-A only; includes 
check digits)
EAN, JAN: 8 or 13 (includes 
check digits)

CODE39 
(*1)

ASCII data 1 to 32
(excludes start/stop codes)

CODE128/
EAN128

ASCII data 1 to 32
(excludes check characters)

Codabar 
(NW7)

4 start/stop 
characters,
numbers, 6 symbols

1 to 32
(excludes start/stop codes)

ITF Numbers 2 to 32 (always even number of 
digits)

Code Character set

PDF417 ASCII data,
Binary data (multibyte 
characters)
Mixture of the types 
of data above

QR code Numbers, 
alphabetical 
characters, symbols, 
multibyte characters,
control codes
Mixture of the types 
of data above

Examples of Two-dimensional Code

PDF417 Q
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 For details on the parameters for QR code detection, refer to "QR 

Code Detection Parameters" (page 36).
However, divided QR codes cannot be scanned. Thin element width/

module width
 UPC/EAN/JAN

For 300 dpi or more: 0.264 mm/0.010 in. or 

than 300 dpi: 0.30 mm/0.012 in. or 

/CODE128/EAN128/
(NW7)
dpi or more: 020 mm/0.008 in. or 

than 300 dpi: 0.30 mm/0.012 in. or 

dpi or more: 0.254 mm/0.010 in. or 

than 300 dpi: 0.30 mm/0.012 in. or 

5 in. or less
AN/JAN/CODE128/EAN128, this is 
 the widest element, which is 
o the total width of four modules.)

N/JAN/CODE128/EAN128/ITF
etween characters
/Codabar(NW7)

 or less than either 1.52 mm / 0.06 
ee times the width of the thin 
 whichever is larger, and equal to 
 than the thin element width

Parameter

m / 0.01 to 0.08 in.

Menu option Parameter
The following lists the barcode detection parameters:
One-dimensional Barcode Detection Parameters

PDF417 Detection Parameters

Menu option Parameter

Barcode height 10 to 30 mm / 0.39 to 1.18 in.

Barcode width 300 mm / 11.81 in. or less

Barcode margin 5 mm / 0.20 in. or more on each side of 
barcode
(The left and right edges of ITF are either 5 
mm / 0.20 in. or more, or six times the width of 
the thin element or more, whichever is larger)

Barcode color Black

Barcode base color White

Resolution 200 to 600 dpi

Barcode angle Horizontal and vertical

more
For less 
more

 CODE39
Codabar
For 300 
more
For less 
more

 ITF
For 300 
more
For less 
more

Wide element width 14.0 mm/0.5
(For UPC/E
the width of
equivalent t

Gap between 
characters

 UPC/EA
No gap b

 CODE39
Equal to
in. or thr
element,
or larger

Menu option

Module width 0.3 to 2.0 m
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Module height The recommended module height is three 
times of module length or more

Menu option Parameter

Barcode color Black

pi

nd vertical

the combination of the parameters, 
.
e barcode detecting area, the one 

ed only when the Premium option 
nable the Premium option, refer to 
ondition" (page 68).
defined barcode type for this 
parated wrongly, and the scanned 
nding on the scan settings. It is 
r the area of barcodes to be 

may decrease the recognition 
on the sheets. If the sheet is not 
ged, replace it with a new sheet.
gnized correctly or get smudged, 
xt recognized from the barcode 
d/or characters unavailable for a 
 " < > |, those are replaced with " " 
created folder or file name.
red.
ed correctly depending on the 
r driver settings and/or the print 
ensuring that the barcode is 

Menu option Parameter
QR Code Detection Parameters

(When the module height is less than two 
times of the module width, the module can not 
be recognized.)

Barcode width (overall 
width)

25.5 to 170.0 mm / 1.00 to 6.69 in.

Barcode height 10.0 to 30.0 mm / 0.39 to 1.18 in.

Barcode margin 5 mm / 0.20 in. or more on each side of 
barcode

Barcode color Black

Barcode base color White

Resolution 200 to 600 dpi

Barcode angle Horizontal and vertical

Error correction level 0/2/3/4/5/6/7

Menu option Parameter

Model Model 2
ECI and FNC1 modes are not supported

Version 3 to 10

Information type Numbers, alphabetical characters, symbols, 
multibyte characters, control codes
Mixture of the types of data above

Cell size 0.40 mm / 0.02 in. or more

Barcode margin 4 cells or more on each side of barcode

Barcode base color White

Resolution 300 to 600 d

Barcode angle Horizontal a

Error correction level L/M/Q/H

ATTENTION
 When the barcode does not meet 

it may not be recognized correctly
 If there are multiple barcodes in th

recognized first will be enabled.
 Two-dimensional codes can be us

is enabled. For details on how to e
"2.10 Premium Option Enabling C

 If you scan a document with an un
function, the document may be se
images may also be deleted depe
recommended to limit the types o
detected.

 Using the same sheet repeatedly 
accuracy due to accumulated dirt 
recognized correctly or gets smud

 If the barcode sheets are not reco
print new barcode sheets. If the te
includes any control characters an
file or folder name, such as \ / : * ?
(space) or "_" (underscore) in the 
Some control characters are igno

 The barcode may not be recogniz
document (if skewed), the scanne
status of barcodes. Operate after 
correctly recognized.
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The example case shows how to limit the area to detect the 
barcode to scan documents.

3 Select the [Document separation] tab, and then select the 
[Use job separator (barcode)] check box.

x appears.

 barcode-printed sheet, select the 
k box.
n disable the save of the image on 
ed sheets by selecting the 
parator] check box.
1 Scan a sample image for barcode recognition.
For how to perform a scan, refer to "2.5 Scanning Methods (Scan)" 
(page 20) or "2.6 Scanning Methods (Batch Scan)" (page 23).

2 Create a new profile in ScandAll PRO, and then open the 
[Profile Editor] dialog box.
For how to create profiles, refer to "2.6 Scanning Methods (Batch 
Scan)" (page 23). 4 Click the [Setup] button.

The [Barcode Setting] dialog bo

HINT
The image created with ScandAll PRO can be used for samples.
Details of the conditions are as follows:

*1: Progressive JPEG is not included.
*2: For Multipage TIFF, the first page displayed is the sample 

image.

File 
format

Image type Paper size Resolution

BMP Monochrome
8-bit Gray
24-bit Color

Height and 
width:
50 to 453 mm

200 dpi or 
higher

JPEG
(*1)

8-bit Gray
24-bit Color

TIFF
(*2)

Monochrome
8-bit Gray
24-bit Color

HINT
 To not save the image of the

[Remove job separator] chec
 In Duplex Scan mode, you ca

the back of the barcode-print
[Remove next page of job se
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The selected area is displayed in shaded red.

 Barcode properties
You can specify advanced settings for barcode recognition from 
the [Barcode] menu  [Advanced] ("Two-dimensional code" 
can be selected when the Premium option is enabled). For 

 items you can configure, refer to 

d decreases, limit the barcode 
w the barcode area to improve the 

ecognition results of the sample 
nu  [Recognize Barcode].
rcode recognition results] dialog 
n is enabled.
HINT
 Sample image display

The [Barcode Setting] dialog box displays an image which has 
been displayed once and then saved. If no relevant image is 
saved, the image currently displayed on the main window is 
used as a sample image.
However, an image is not displayed on the conditions below.
- There is no image on the main window
- An image on the main window does not meet the condition as 

a sample image.
If there is no image displayed or if you want to change the sam-
ple image to be shown, select the [File] menu  [Open] to 
select a sample image.

information about the setting
the ScandAll PRO Help.

If the barcode scanning spee
types to be detected or narro
scanning speed.

 Barcode recognition results
You can check the barcode r
image from the [Barcode] me
This section explains the [Ba
box when the Premium optio
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[File] menu  [Exit] to save the setting contents.

7 Insert the barcode-printed sheets wherever you want the 

HINT
Follow the procedure below to save images of a scanned 
document that are separated by barcode-printed sheets, in 
separate folders, and name each folder with a character string 

rcode:
 [Separator] to saving folder 
 and [Page Counter] to scanned 
ple.
Rule] check box on the [File format
the [Profile Editor] dialog box, and
n.
x appears.
limiters], [Character string 1], and
 applied].

e [Folder delimiters] is the folder
ages are saved in this folder.

image0001.jpg
January

image0002.jpg

image0001.jpg
February

image0002.jpg

image0001.jpg
March

image0002.jpg

lders
file/folder to separate.
Load the document with the barcode-printed sheets face-down on the 
ADF paper chute.

8 Specify the created profile and perform a batch scan.
For how to perform a batch scan, refer to "2.6 Scanning Methods 
(Batch Scan)" (page 23).

Barcode-printed
sheets

recognized from the relevant ba
This section explains how to set
names, and [Character string 1]
document file names as a exam

1 Select the [Use the Name 
and Name scheme] tab in 
click the [Name Rule] butto
The [Name Rule] dialog bo

2 Set [Separator], [Folder de
[Page Counter] in [Settings

[Separator] situated abov
name, and the scanned im
Saving example:

Saving foWhen specifying
[Separator]
as folder names
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If [Folder delimiters] is not set, no folders are created, and
[Separator], [Character string 1], and [Page Counter] will be
the file name.
Saving example:
Saving foldersWhen not specifying
[Separator]
as folder names

Januaryimage0001.jpg
Januaryimage0002.jpg

Februaryimage0001.jpg
Februaryimage0002.jpg

Marchimage0001.jpg
Marchimage0002.jpg
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Quickly

You can perform a scan simply by pressing the [Scan] or 

6 Select the [Events] tab, and then select the event.
From the [Select an event] menu, select the event that you want to 
launch an application for.

cted:
button is pressed)
 to] button is pressed while a 

ed on the operation panel)

tion panel depend on the selected 
[Send to] button on the scanner. To do this, you first need to 
assign your desired scanning applications to these buttons.
Computer Settings

1 Confirm that the scanner is connected properly to your 
computer, then power on the scanner.
For how to connect the scanner to your computer, refer to the 
Operator's Guide for the scanner you are using.

2 Select the [Start] menu  [Control Panel].
The [Control Panel] window appears.

3 Select the [Hardware and Sound] icon.
The [Hardware and Sound] window appears.

4 Select the [Scanners and Cameras] icon.
The [Scanners and Cameras] window appears.

5 Display the properties of the scanner.
Double-click the scanner icon.

The following events can be sele
 Scan Button (when the [Scan] 
 Send to 1 to n (when the [Send

number (from 1 to n) is display

ATTENTION
Numbers displayed on the opera
scanner.
Example: Send to 1 to 9
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Contents7 Select the application to be launched when an event 
occurs.
Select the [Start this program] option button under [Actions], and then 
select the application you want to use.

11 Select the [Event] tab.

12 Select the action for the event you selected in Step 6, and 
then select a profile from the list you want to use for 

 profile beforehand.
 to "2.6 Scanning Methods (Batch 
8 Click the [OK] button.

9 Start ScandAll PRO.

10 Select the [Tool] menu  [Preferences].
The [Setup] dialog box appears.

scanning.

13 Click the [OK] button.

14 Exit ScandAll PRO.

HINT
 This completes the computer settings for an application other 

than ScandAll PRO. Then, configure settings for your scanner 
according to "Scanner Settings" (page 43).

 The windows that appear and the operations differ by the 
operating system that you are using.

 If you want to link with other buttons here, repeat Steps 6 to 7, 
and finally perform Step 8.

HINT
You need to create the required
For how to create profiles, refer
Scan)" (page 23).
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ContentsScanner Settings

1 Configure the buttons on the scanner.
Example of ADF type Example of Flatbed type

HINT
Operation panel specifications differ depending on the scanner.
For details, refer to the Operator's Guide for the scanner you are 
using.
 When using the [Scan] button
No setting changes are needed.

 When using the [Send to] button
1 Press the [Function] button to change the number displayed on 

the operation panel.

2 Match the event set at the computer (Send to 1 to n) and the 
number.
To perform the event configured with [Send to 2], for example, 
display [2] on the operation panel.

2 Press the configured button on the scanner.
A batch scan is executed according to the selected profile's

settings.

ATTENTION
Depending on the scanner you are using, the profile name 
specified as [Send to 1 to n] in Step 12 is displayed on the 
operation panel. However, the profile name is not displayed 
correctly if...
 the name is set in a language that the scanner does not support 

(Unsupported languages are displayed with ■)
 the name does not fit into the display range (16 characters × 3 

rows)

Function

Hopper  Height

Paper  Thickness
Thin

Send to Scan

Thick

[Scan] button

[Send to] button

[Scan] button

[Send to] button
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ContentsSpecifying the Result of Zone OCR as a File 
Name

ScandAll PRO supports the Zone OCR function. With this 

1 Scan a sample image for Zone OCR.
For how to perform a scan, refer to "2.5 Scanning Methods (Scan)" 
(page 20) or "2.6 Scanning Methods (Batch Scan)" (page 23).

dAll PRO, and then open the 

 "2.6 Scanning Methods (Batch 

HINT
ll PRO can be used for samples.
follows:

luded.
page displayed is the sample 

Paper size Resolution

Height and 
width:
50 to 453 mm

200 dpi or 
higher
function, you can perform Zone OCR on a specified area of a 
scanned document and output the recognition result to an 
indexing information file. You can also use character strings 
recognized by the Zone OCR as an image file or folder name.
This section explains how to set the character strings 
recognized by Zone OCR as a file name.

The procedure is as follows:
The example case shows how to set [Character string 1], 
[Page Counter], and the Zone OCR results to file names.

2 Create a new profile in Scan
[Profile Editor] dialog box.
For how to create profiles, refer to
Scan)" (page 23).

HINT
 The following resolutions are recommended for images. Resolution 

higher than 600 dpi cannot be recognized for Color/Gray.
- Monochrome: 400/600 dpi
- Color/Gray: 200/300 dpi

 The deskew function of the driver and the orientation correction filter 
may improve the recognition rate. 

The image created with ScandA
Details of the conditions are as 

*1: Progressive JPEG is not inc
*2: For Multipage TIFF, the first 

image.

File 
format

Image type

BMP Monochrome
8-bit Gray
24-bit Color

JPEG
(*1)

8-bit Gray
24-bit Color

TIFF
(*2)

Monochrome
8-bit Gray
24-bit Color
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Contents3 Select the [Filter] tab, and then select the [Enable Zone 
OCR] check box.

5 Click and drag to select an area for Zone OCR.
The selected area is displayed in shaded red.

log box displays an image which 
 then saved. If no relevant image 
 displayed on the main window is 

played on the conditions below.
ain window
ow does not meet the condition as 

 or if you want to change the sam-
t the [File] menu  [Open] to 
4 Click the [Setup] button.
The [Zone OCR Settings] dialog box appears.

HINT
 Sample image display

The [Zone OCR Settings] dia
has been displayed once and
is saved, the image currently
used as a sample image.
However, an image is not dis
- There is no image on the m
- An image on the main wind

a sample image.
If there is no image displayed
ple image to be shown, selec
select a sample image.
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Contents8 Set [Character string 1], [Page Counter], and [Zone OCR] 
in [Settings applied].

nter], and the Zone OCR result are

canner.

nd perform a batch scan.
 refer to "2.6 Scanning Methods 

 Zone OCR advanced settings
You can specify advanced settings for Zone OCR from the 
[Zone OCR] menu  [Advanced]. For information about the set-
ting items you can configure, refer to the ScandAll PRO Help.

e character strings recognized by 

ecognized. 
> |) are replaced with " " (space) or 

 feed characters are deleted.
type file, include [Page Counter] to 
nter is not included, the file name 

e created, the character string 
 on the top page will be used for 
6 After you have completed the area selection, select the 
[File] menu  [Exit] to save the setting contents.

7 Click the [Name Rule] button on the [File format and 
Name scheme] tab in the [Profile Editor] dialog box.
The [Name Rule] dialog box appears.

[Character string 1], [Page Cou
used for the file name.

9 Load the document in the s

10 Specify the created profile a
For how to perform a batch scan,
(Batch Scan)" (page 23).

 Zone OCR results
You can check the sample image Zone OCR result from the 
[Zone OCR] menu  [Zone OCR]. ATTENTION

Note the following when using th
Zone OCR as a file name.
 Up to 32 characters can be r
 Illegal characters (\ / : ? * " < 

"_" (underscore).
 If there are several lines, line
 If outputting the single page 

the file name. If the page cou
may be duplicated.

 When multipage type files ar
recognized at the Zone OCR
the file name.
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Contents
HINT
Confirm and correct zone OCR results

When the [Confirm and correct zone OCRed text] check box is 
selected on the [Zone OCR Advanced Settings] dialog box, the 

[Zone OCRed Text Confirmation and Correction] dialog box is 
displayed when a batch scan is performed. You can confirm 
and correct zone OCR results in this dialog box.
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ContentsSpecifying the Result of Barcode Recognition as 
a File Name

ScandAll PRO supports the barcode recognition function. With 

1 Scan a sample image for barcode recognition.
For how to perform a scan, refer to "2.5 Scanning Methods (Scan)" 
(page 20) or "2.6 Scanning Methods (Batch Scan)" (page 23).

dAll PRO, and then open the 

 "2.6 Scanning Methods (Batch 

ll PRO can be used for samples.
follows:

luded.
page displayed is the sample 

Paper size Resolution

Height and 
width:
50 to 453 mm

200 dpi or 
higher
this function, you can perform barcode recognition on a 
specified area of a scanned document and output the 
recognition results to an indexing information file. You can also 
use character strings recognized with barcode recognition as 
an image file name or folder name.
In addition, you can save images into separate files by using 
barcode-printed sheets as separators. When you do so, you 
can also set the recognition result of the barcode printed on 
the sheet as a file name. For details, refer to "Dividing a 
Multipage Document Using Barcodes" (page 34).

The procedure is as follows:
The example case shows how to limit the area to detect the 
barcode and how to set [Character string 1], [Page Counter], 
and the barcode recognition result as file names to scan 
documents.

2 Create a new profile in Scan
[Profile Editor] dialog box.
For how to create profiles, refer to
Scan)" (page 23).

HINT
The recommended resolution for an image to be used for barcode 
recognition is 200 to 600 dpi.

HINT
The image created with ScandA
Details of the conditions are as 

*1: Progressive JPEG is not inc
*2: For Multipage TIFF, the first 

image.

File 
format

Image type

BMP Monochrome
8-bit Gray
24-bit Color

JPEG
(*1)

8-bit Gray
24-bit Color

TIFF
(*2)

Monochrome
8-bit Gray
24-bit Color
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Contents3 Select the [Filter] tab, and then select the [Perform 
barcode recognition] check box.

5 Click and drag to select an area for barcode recognition.
The selected area is displayed in shaded red.

 box displays an image which has 
n saved. If no relevant image is 
isplayed on the main window is 

played on the conditions below.
ain window
ow does not meet the condition as 

 or if you want to change the sam-
t the [File] menu  [Open] to 
4 Click the [Setup] button.
The [Barcode Setting] dialog box appears.

HINT
 Sample image display

The [Barcode Setting] dialog
been displayed once and the
saved, the image currently d
used as a sample image.
However, an image is not dis
- There is no image on the m
- An image on the main wind

a sample image.
If there is no image displayed
ple image to be shown, selec
select a sample image.
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Contents7 Click the [Name Rule] button on the [File format and 
Name scheme] tab in the [Profile Editor] dialog box.
The [Name Rule] dialog box appears.

ge Counter], and [Barcode] in 

unter], and the barcode recognition
e.

canner.

 Barcode properties
You can specify advanced settings for barcode recognition from 
the [Barcode] menu  [Advanced] ("Two-dimensional code" 
can be selected when the Premium option is enabled). For 

e character strings recognized 
e name.
ecognized. 
 recognized correctly or get 
 sheets. If the text recognized from 
trol characters and/or characters 

r name, such as \ / : * ? " < > |, 
pace) or "_" (underscore) in the 

 ignored.
type file, include [Page Counter] to 
nter is not included, the file name 

e created, the character string 
recognition on the top page will be 
6 After you have completed the area selection, select the 
[File] menu  [Exit] to save the setting contents.

8 Set [Character string 1], [Pa
[Settings applied].

[Character string 1], [Page Co
results are used for the file nam

9 Load the document in the s

information about the setting items you can configure, refer to 
the ScandAll PRO Help.

 Barcode recognition results
You can check the barcode recognition results of the sample 
image from the [Barcode] menu  [Recognize Barcode].
This section explains the [Barcode recognition results] dialog 
box when the Premium option is enabled.

ATTENTION
Note the following when using th
with barcode recognition as a fil
 Up to 32 characters can be r
 If the barcode sheets are not

smudged, print new barcode
the barcode includes any con
unavailable for a file or folde
those are replaced with " " (s
created folder or file name.
Some control characters are

 If outputting the single page 
the file name. If the page cou
may be duplicated.

 When multipage type files ar
recognized with the barcode 
used for the file name.
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Contents10 Specify the created profile and perform a batch scan.
For how to perform a batch scan, refer to "2.6 Scanning Methods 
(Batch Scan)" (page 23).
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ContentsSaving Folders for Each Batch Scan

When the same profiles are used consecutively, multiple files 
with the same file name are created and may overwrite the 

2 Select the [File format and Name scheme] tab, and then 
select the [Use a batch folder] check box.

canner.

nd perform a batch scan.
ted, the [Batch Folder Name] dialog

 refer to "2.6 Scanning Methods 
previous batch scan output file.
With ScandAll PRO, in order not to overwrite the file, you can 
make a setting to create folders for saving image files each 
time a batch scan is executed.

The procedure is as follows:

1 Create a new profile in ScandAll PRO, and then open the 
[Profile Editor] dialog box.
For how to create profiles, refer to "2.6 Scanning Methods (Batch 
Scan)" (page 23).

3 Load the document in the s

4 Specify the created profile a
When the batch scan is execu

box appears.

For how to perform a batch scan,
(Batch Scan)" (page 23).
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Contents5 Enter a batch folder name, and click the [OK] button. Saving example:

image0001.jpg
Batch_0001

image0002.jpg

image0001.jpg
Batch_0002

image0002.jpg

image0001.jpg
Batch_0003

image0002.jpg

Saving foldersWhen using folders created
for each batch scan
The batch scan starts and the scanned image file is saved in the
created folder with the specified name.

HINT
If the names of the batch folders include a number of 8 or less 
digits at the end, names are created by adding "1" to the previously 
specified number. In the case where adding "1" would increase the 
number of digits, the number returns to "1" instead.
If folder names include a number of more than 8 digits at the end, 
the number does not vary.
Example:

Specified batch folder name Next batch folder name

Batch_0009 Batch_0010

Batch_9999 Batch_0001

Batch_000000001 Batch_000000001
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ContentsSaving Scanned Images from a Batch Scan to 
SharePoint Server

With ScandAll PRO, you can perform a batch scan and save 

3 Select [Upload to SharePoint Server] and click the [Setup] 
button.

 the SharePoint Server] dialog box

ng the scanned images to 

r] dialog box.

canner.
the scanned image to SharePoint Server.

The procedure is as follows:

1 Create a new profile in ScandAll PRO, and then open the 
[Profile Editor] dialog box.
For how to create profiles, refer to "2.6 Scanning Methods (Batch 
Scan)" (page 23).

2 Click the [Linking] tab, and select the [Link up with the 
following process] check box.

The [Information to transfer to
appears.

4 Specify the settings for savi
SharePoint Server.

5 Click the [OK] button.
This returns to the [Profile Edito

6 Load the document in the s

ATTENTION
The server on which SharePoint Server is running requires some 
ScandAll PRO modules to be installed. In order to install the modules, 
run "ScandAllPROSrv.exe" on the server, that is stored under 
\ScandAll\ScandAll in the Setup DVD-ROM or in the downloaded 
installer.
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Contents7 Specify the created profile and perform a batch scan.
When the batch scan is executed, the image is saved in SharePoint

Server.
HINT
For more information, refer to the ScandAll PRO Help.
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ContentsRestarting a Suspended Batch Scan

With ScandAll PRO, when a "batch scan" is performed, the 
batch scan working state is temporarily saved automatically

ved batch scan working state 

Restore Batch Scan].
t] dialog box appears.

nt to restore, and click the 

cted batch scan is restored on the
 additional operations for the batch
ing or image editing.

Restore temporary saved 
batch scan working state to 
restart the batch scan

e ScandAll PRO Help.
You can restart the scanning by restoring the temporarily 
saved batch scan working state.
For example, you can continue the interrupted batch scan the 
next day. Similarly, if another more urgent scan needs to be 
performed while a batch scan is running, its working state can 
be saved, allowing it to be restarted at a later time.

The procedure to restore the sa
is as follows:

1 Select the [Scan] menu  [
The [Saved batch scan data lis

2 Select a batch scan you wa
[Restore] button.

The working status of the sele
main window. You can perform
scan, such as additional scann

Perform a batch scan
(Automatically saved)

Perform another scan

HINT
For more information, refer to th
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ContentsOutputting Indexing Information File and Linking 
with an Application

With ScandAll PRO, you can output the result of Zone OCR 

3 In the [Profile Editor] dialog box, select the [Linking] tab, 
and then select the [Output indexing information] check 
box.

 button.
ox appears.

dexing Info] dialog box when the 
 details about the dialog box when 
 refer to the ScandAll PRO Help.
and the barcode recognition result to the indexing information 
file. Other items such as the image file name (full path) and 
the page number in the document are also output to the 
indexing information file. You can link with another application 
by specifying the name of the indexing information file name 
as a parameter.
This function allows you to create a profile, such as for saving 
image data with indexing information in the server.

The procedure is as follows:

1 Create a new profile in ScandAll PRO, and then open the 
[Profile Editor] dialog box.
For how to create profiles, refer to "2.6 Scanning Methods (Batch 
Scan)" (page 23).

2 Set the barcode or Zone OCR in the [Profile Editor] dialog 
box.
 For details on how to set a barcode, refer to "Dividing a Multipage 

Document Using Barcodes" (page 34) or "Specifying the Result of 
Barcode Recognition as a File Name" (page 48).

 For details on how to set Zone OCR, refer to "Specifying the Result 
of Zone OCR as a File Name" (page 44).

4 Click the [Set Indexing Info]
The [Set Indexing Info] dialog b

HINT
This section explains the [Set In
Premium option is enabled. For
the Premium option is disabled,
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Contents6 Click the [OK] button.
This returns to the [Profile Editor] dialog box.

HINT
 saved in the folder specified with 
mat and Name scheme] tab, in the 

r] check box is selected, indexing 
 the batch folder.
 of the following types. The 
utput items.

tails of file types, refer to the 

] File name (full path)
 document batch [TAB]
rcode recognition 

name (full path)", "Current
", "Zone OCR results",
5 Specify the name and type of the file to be output.

HINT
The following settings are available only when the Premium option 
is enabled.
 Delimiter
 Output per job
 Output format
 Character string
For details on how to enable the Premium option, refer to "2.10 
Premium Option Enabling Condition" (page 68).

 Indexing information files are
[Folder Name] in the [File for
[Profile Editor] dialog box.
When the [Use a batch folde
information files are output to

 Indexing information files are
examples below are default o
For information about the de
ScandAll PRO Help.
- Unicode Text format

- CSV format

YYYY/MM/DD hh:mm:ss [TAB
[TAB] Current page number in
"Zone OCR results" [TAB] "Ba
results"

"YYYY/MM/DD hh:mm:ss","File 
page number in document batch
"Barcode recognition results"
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Contents8 Select the [Launch another application] option button, and 
click the [Setup] button.

s.

ialog box.
ation to be launched

- XML format

<?xml version = "1.0" encoding = "utf-8"?>
<root>
<page>
7 Select the [Link up with the following process] check box 
on the [Linking] tab. The [Option] dialog box appear

9 Specify the settings on the d
[Application Program]: The applic
[Argument-Parameter]: %i

<item name = "Date&Time" value = "Date and Time">
<item name = "Full Path" value = "File name (full path)"/>
<item name = "Page Number in Document" value =
"Current page number in document batch"/>
<item name = "Zone OCR" value = "Zone OCR results"

<item name = "Barcode" value = "Barcode recognition

</page>
results"/>

<page>
<item name = "Date&Time" value = "Date and Time">
<item name = "Full Path" value = "File name (full path)"/>
<item name = "Page Number in Document" value =
"Current page number in document batch"/>
<item name = "Zone OCR" value = "Zone OCR results"

<item name = "Barcode" value = "Barcode recognition

</page>
results"/>

.

.
</root>
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Contents10 Click the [OK] button.
This returns to the [Profile Editor] dialog box.

11 Load the document in the scanner.
12 Specify the created profile and perform a batch scan.
After the document is scanned, ScandAll PRO launches the

application and passes the indexing information file name to the
application as a parameter.

For how to perform a batch scan, refer to "2.6 Scanning Methods 
(Batch Scan)" (page 23).
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ContentsDetecting Errors in the Scanned Document (fi-
6800)

If an error is detected in the scanned document, the 

 When selecting the [Mark pages when error is detected by 
Automatic Image Quality Checker] check box
The scanned document is checked for any folds or tears.
If an error is detected, it is indicated by changing the background of 

taining the error to yellow.
s when multifeed is detected] check 

cked for any errors where multiple 
re sheets of different lengths are fed.
while scanning, the scan is 
er all scans are completed, the 
changing the background of the 
ing the error to red.

ttings] button on the [Scan] 
ttings.
s when error is detected by 
ker] check box

Settings

[Rotation] tab in the [Option] dialog 
played by clicking the [Option] 
select [Automatic Page Size 
n] or [Black Background] for 

atic Size and Skew detection].

re the parameter as either of the 
g:
ct [Automatic], [Deskew], or [Long 
e] for [Cropping] on the [Main] tab.
ct [Black] for [Backing] on the 
er Handling] tab.
background color of the thumbnail changes automatically so 
that the user can recognize the target image easily.

The procedure to set the automatic error detection and 
notification is as follows:

1 Create a new profile in ScandAll PRO, and then open the 
[Profile Editor] dialog box.
For how to create profiles, refer to "2.6 Scanning Methods (Batch 
Scan)" (page 23).

2 On the [Scan] tab, select the [Mark pages when error is 
detected by Automatic Image Quality Checker] and [Mark 
pages when multifeed is detected] check boxes, and click 
the [OK] button.

the thumbnail for the page con
 When selecting the [Mark page

box
The scanned document is che
pages are fed at a time or whe
If a multifeed error is detected 
continued without stopping. Aft
multifeed error is indicated by 
thumbnail for the page contain

3 Click the [Detail Scanner Se
tab to configure the scan se
 When selecting the [Mark page

Automatic Image Quality Chec

Scanner driver

TWAIN driver On the 
box dis
button, 
Detectio
[Autom

ISIS driver Configu
followin
 Sele

Pag
 Sele

[Pap
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Contents
 When selecting the [Mark pages when multifeed is detected] check 

box

Scanner driver Settings

e of the document, errors may be 
 recognized, since they are 
he scanned image.
 image yourself even when you 

ge with an error by selecting the 
an].

Fold 
detected
4 When you have completed the settings, click the [OK] 
button.
This returns to the [Profile Editor] dialog box.

5 Click the [OK] button in the [Profile Editor] dialog box to 
add the profile.

6 Load the document in the scanner.

7 Specify the created profile and perform a batch scan.
If there is an error in the scanned document, the target thumbnail is

displayed with background of a different color.

TWAIN driver On the [Job/Cache] tab in the [Option] 
dialog box displayed by clicking the 
[Option] button, select [Check Overlapping 
(Ultrasonic)], [Check Length], or [Check 
Overlapping and Length] for [Multifeed 
Detection].

ISIS driver On the [Multifeed Detection] tab, select 
[Paper Overlap] or [Paper Length] for 
[Multifeed Detection].

ATTENTION
Depending on the color or shap
detected by mistake or fail to be
detected only in the corners of t
Make sure to check the scanned
use this detection function.

HINT
You can replace a scanned ima
[Page] menu  [Replace]  [Sc
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age, select an option from the 

2.8 Useful Post-Scan Functions

Used to...

 previous marked page.

 next marked page.

 first marked page.

 last marked page.

 selected thumbnail.

thumbnails.

il by right-clicking and selecting 
 the thumbnail is selected.
Marking Thumbnails

This function is useful to distinguish a certain desired image 
from others.

The procedure is as follows:

1 Load the document in the scanner and perform a scan.

2 Select the thumbnail of the desired image, and then select 
the [Mark] menu  [Mark].
The background of the selected thumbnail turns to orange.

3 After marking the desired im
following:

HINT
You can also mark a thumbnail with orange background by right-
clicking and selecting [Mark Selected Pages] while the thumbnail is 
selected.

Menu option

Previous Marked 
Page

Display the

Next Marked 
Page

Display the

First Marked 
Page

Display the

Last Marked 
Page

Display the

Unmark Unmark the

Unmark All Unmark all 

HINT
You can also unmark a thumbna
[Unmark Selected Pages] while
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You can save scanned images to SharePoint.
The procedure is as follows:

1 Load the document in the scanner and perform a scan.

2 Select the [File] menu  [Send]  [Microsoft SharePoint].
The [Scan to Microsoft SharePoint] dialog box appears.

3 Save the scanned images to SharePoint.
For more information, refer to Scan to Microsoft SharePoint User 
Guide.

ATTENTION
Scan to Microsoft SharePoint needs to be installed.
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ll Programs]  [Fujitsu 
 [Profile Exporter].
x appears, and profiles registered in
e profile list.

e profiles to be exported.

ars.

2.9 Exporting and Importing Profiles

porter] dialog box, refer to the 
ScandAll PRO supports the export and import of profiles.
"Profiles" here include batch scan settings (profiles) and other 
settings (connected driver settings and others). You can select 
profiles to be exported.
Profiles are exported and imported in the following steps.

1 Export the ScandAll PRO profiles by using the export function.
2 Import the exported profiles into ScandAll PRO into another computer

by using the import function.

Exporting Profiles

Export ScandAll PRO profiles into an export file (.cab).

The procedure is as follows:

1 Select the [Start] menu  [A
ScandAll PRO]  [Tools] 
The [Profile Exporter] dialog bo

ScandAll PRO are shown in th

2 Select the check boxes of th

3 Click the [Run] button.
The [Save As] dialog box appe

ATTENTION
 This function is not available when ScandAll PRO or Web Parts is 

running. Exit the ScandAll PRO or the Web parts, and perform this 
function.
For information about Web Parts, refer to the SharePoint Help. 

 ScandAll PRO profiles of the currently logged in user are exported. 
Other users' ScandAll PRO profiles cannot be exported.

HINT
For details about the [Profile Ex
ScandAll PRO Help.
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button.
The ScandAll PRO profiles are exported, and the message of the

export completion appears.

1 Select the [Start] menu  [All Programs]  [Fujitsu 
ScandAll PRO]  [Tools]  [Profile Importer].
The [Profile Importer] dialog box appears.

d.
orted in "Exporting Profiles" (page 

 perform one of the following:

specify the file.
rop operation.

porter] dialog box, refer to the 

ytes long.
5 Click the [OK] button.

Importing Profiles

Import the profiles which were exported in "Exporting Profiles" 
(page 65) into another computer.

The procedure is as follows:

2 Select the file to be importe
Select the file (.cab) that was exp
65).
To specify the file to be imported,
 Enter the path to the file.
 Click the [Browse] button, and 
 Specify the file by a drag and d

HINT
Exported profiles can be used as a backup.

ATTENTION
 It is recommended to create a backup of the profiles on the import 

side beforehand.
 This function is disabled when ScandAll PRO or Web Parts is 

running. Exit the ScandAll PRO or the Web parts, and perform this 
function.
For information about Web Parts, refer to the SharePoint Help.

 The language setting on the exporting and importing sides must be 
the same. The exported profiles and system configuration data 
cannot be imported if the language setting differs between them.

HINT
For details about the [Profile Im
ScandAll PRO Help.

ATTENTION
The file path can be up to 255 b
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You can select one of the following types of import:
 Replace All

All profiles currently registered in ScandAll PRO are removed, and 

replaced by the profiles in the import file.

 Add
The profiles in the import file are added to ScandAll PRO.
If a profile currently registered in ScandAll PRO has the same 
name as a profile in the import file, you can overwrite with the 
profile in the import file by checking the [Overwrite profile of the 
same name] check box.

4 Click the [Run] button.
The message of the import completion appears.

5 Click the [OK] button.

HINT
If select run [Add], any event set up in ScandAll PRO on the 
exporting side will also be set up in ScandAll PRO on the importing 
side. (Events can be specified in the [Event] tab in the [Setup] 
dialog box opened by selecting [Tool]  [Preferences].)

HINT
When profiles have been imported, import results are created. The 
import results are saved in the following folder with the file name 
"ScandAllImpProfile.csv":
C:\Users\UserName\Documents\ScandAllPro
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2.10 Premium Option Enabling Condition

The Premium option is enabled when the Premium Upgrade 
option is installed.
To install the Premium Upgrade option, access the download 
site from the Setup DVD-ROM that is bundled with the 
scanner. Download the Premium Upgrade option from the site, 
and then install it.
If the Setup DVD-ROM does not include information about the 
Premium option, you are required to purchase the Premium 
Upgrade option separately.

ATTENTION
Purchasing and installing the Setup DVD of ScandAll PRO V2 or later 
does not enable the Premium option. You are required to purchase the 
Premium Upgrade option separately.

HINT
You can check if the Premium Upgrade option is installed by the 
following steps:

1 Click the [Help] menu  [About ScandAll PRO].
The [About ScandAll PRO] dialog box appears.

2 Check the ScandAll PRO version.
When you find the "Premium" at the end of version number, the
Premium Upgrade option is installed.
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